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Three Rules 
 

 

 1. Ask stupid questions  
 2. Cheat 
 3. Make Mistakes 
 

Source:  Techsoup.org.  This work is licensed under a Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported License.  
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Presenter
Presentation Notes
Ask stupid questions - if you're thinking it, someone else probably is too
Cheat - learn from your neighbor
Make mistakes - we learn a lot from them
Source:  Techsoup.org.  This work is licensed under a Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported License.
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Do you already know how to… 

• How to use a mouse. 
• How to work with windows, toolbars, command 

menus and dialog boxes. 
• Use a Windows operating system (XP, Vista, 

Windows 7). 
• Format text (make text bold, italic, underlined). 
• Change font face and size. 
• Use Undo and Redo. 
• Select text (highlighting). 
• Save presentations. 
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What you will learn 
• Understanding the Ribbon and Backstage. 
• Understanding the Tabs. 
• Creating a presentation. 
• Opening an existing file. 
• Selecting a style for a presentation. 
• Working with text and bullets. 
• Working with non-text objects. 
• Inserting existing slides into a presentation. 
• Adding, rearranging and deleting slides. 
• Checking spelling and grammar. 
• Running a slide show. 
• What else? 
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The Ribbon menu contains the set of 
commands for working in a presentation. 

• Very similar to the Ribbon in MS Word 2010. 
• Organizes PowerPoint’s many features into 

related tabs. 
• Makes it easier to quickly access those you need. 
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Backstage, behind the File tab 

Versions is important if you already have 
presentations that were created in earlier 
versions of Microsoft PowerPoint, or if 
plan to send presentations to people using 
earlier versions of PowerPoint. 



Behind the Home tab 
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Behind the Insert tab 
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Working with a presentation 

• Creating a presentation. 
• Opening an existing file. 
• Selecting a style for a presentation. 
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Creating a new presentation. 

• One way:  StartAll ProgramsMicrosoft 
OfficeMicrosoft PowerPoint 2010 

• Another way: Red File tabNew 
• Yet another: “New” button in Quick Access 

Toolbar 
– If you don’t see a little picture of a blank page, 

click the down arrowhead at right end of Quick 
Access ToolbarNew (adds the “New” button to 
your Toolbar)New button. 
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Launching the PowerPoint 
program or creating a new 
presentation. 



Opening an existing file. 
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Opening an existing file. 
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Selecting a style for a presentation. 
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Creating a slide 
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If you want the new 
slide to have the 
same layout as the 
slide you’re 
viewing, just click 
the “New Slide” 
button. 

If you want the 
new slide to 
have the a 
different layout, 
click the down 
arrowhead on 
the “New Slide” 
button. 



Working with the slides. 

• Working with text and bullets. 
• Working with non-text objects. 
• Inserting existing slides into a presentation. 
• Adding, rearranging and deleting slides. 
• Checking spelling and grammar 
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Adding text 

• Just click where it says 
“Click to add…” and your 
text will automatically 
adjust to fit that space.   

• Create a Title Page: 
• Click:   “Click to add title” 
• Type:   I Love The Library 
• Click:   “Click to add 

subtitle” 
• Type:   (Your Name) 

 



You can also add text anywhere on a 
slide by creating a Text Box. 

Create a Text Box in the lower left corner of your Title 
slide.  
• Click:   Insert tab → Text Box (under the Text Group). 

– An upside-down cross will appear in place of the mouse 
arrow.  

• Click and hold down the left mouse button while 
dragging the icon to make a dotted line box. 

• Type:   Hussey-Mayfield Memorial Public Library 
– If the box is too small for the font size, you can enlarge the 

box OR reduce the font size. 
– To enlarge the Text Box, click-and-drag a corner of the box 

away from the center of the box. 
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Adding and changing bulleted text 

In the Title Text Box, click on the line of text (“Click to add title”): 
• Type:  “Reasons why I love the library” 
In the Object Placeholder, click on the first line  (“Click to add 
text”). 
• Click:  Home Tab →  
• Click:  Bullets icon on the Paragraph panel.  
• Type:  “I love to read.” 
• Press the Enter key. 
• Type:   “I love to learn.” 
• Press the Enter key. 
• Type: “I love to connect.” 
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Reasons why I love the library 

• I love to read. 
• I love to learn. 
• I love to connect. 
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Working with lists 
To make a numbered list, Click:  the Numbers icon on the 
Paragraph panel. 
 
To indent all three lines of text, highlight all three lines: 
• Click: the indent-right icon on the Paragraph panel 
 
To “outdent” the text, highlight all three lines: 
• Click: the outdent icon on the Paragraph panel 
 
On the Paragraph panel, you can also make your text 
flush left, centered, flush right, or fully justified. 
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Working with non-text objects 
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FIRST: Stop your cursor over each of the 
images below and see what appears for each 
one, but DON’T CLICK. 

SECOND:  
1. Click on Insert Table. 
2. Click on Insert Chart. 
3. Click on Insert SmartArt Graphic 
4. Click on Insert Picture from File 
5. Click on Clip Art 
6. Click on Insert Media Clip 



Adding a picture 
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Click on Insert Picture from File. 

Find the folder called HMMPL PowerPoint Files. 
• Double-click the folder to open it. 
• Double-click on the file called “Salisbury, England” 

Presenter
Presentation Notes
Show this slide in Edit mode so the “Click to add text” box can be seen.



Working with pictures 
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Click once on this picture. 

Place your cursor 
over the little 
circle in any corner 
of the picture. 
• Hold down the 

left mouse 
button. 

• Move the 
cursor away 
from the center 
of the picture. 

Raise your finger and 
rest the cursor to the 
little square on any 
side of the picture. 
• Hold down the 

left mouse 
button. 

• Move the cursor 
away from the 
center of the 
picture. 



Inserting existing slides into a 
presentation. 
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Presenter
Presentation Notes
Demonstrate inserting slides.



Adding, rearranging and deleting 
slides. 
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Presenter
Presentation Notes
Demonstrate adding, arranging and deleting slides.



Checking spelling and grammar. 
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Presenter
Presentation Notes
Demonstrate spelling and grammar check.



Quick Access Toolbar:  Put into one place 
the commands you use most often. 
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Click the down 
arrowhead to see 
what you can add to 
the Quick Access 
Toolbar.  If you don’t 
see the command 
you want, click 
More Commands.  

Presenter
Presentation Notes
The Quick Access Toolbar is a small toolbar that appears directly above the File and Home tabs on the Ribbon. 
To add other commonly used commands to this toolbar, do the following:
To open the Customize Quick Access Toolbar menu, click the arrow next to the toolbar.
Choose one of the commands on the menu. If you don’t see the command you want, click More Commands. 
In the Choose commands from box, click Commands Not in the Ribbon or one of the other options.
Click a command you want from the list.
Click Add.
To save your customizations, click OK.
- or -
On the Ribbon, click the tab containing the command that you want to add to the Quick Access Toolbar. 
Right-click the command, and then click Add to Quick Access Toolbar. 




Instructions for customizing the Quick 
Access Toolbar 

The Quick Access Toolbar is a small toolbar that appears directly above the File and 
Home tabs on the Ribbon.  
To add other commonly used commands to this toolbar, do the following: 
• To open the Customize Quick Access Toolbar menu, click the arrow next to the 

toolbar. 
• Choose one of the commands on the menu. If you don’t see the command you 

want, click More Commands.  
• In the Choose commands from box, click Commands Not in the Ribbon or one of 

the other options. 
• Click a command you want from the list. 
• Click Add. 
• To save your customizations, click OK. 
- or - 
• On the Ribbon, click the tab containing the command that you want to add to the 

Quick Access Toolbar.  
• Right-click the command, and then click Add to Quick Access Toolbar.  
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Running your slide show. 
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What did we learn? 
• Understanding the Ribbon and Backstage. 
• Understanding the Tabs. 
• Creating a presentation. 
• Opening an existing file. 
• Selecting a style for a presentation. 
• Working with text and bullets. 
• Working with non-text objects. 
• Inserting existing slides into a presentation. 
• Adding, rearranging and deleting slides. 
• Checking spelling and grammar. 
• Running a slide show. 
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Sources and help 
• Introduction to PowerPoint, Instructor Notes.  Tenderloin Technology Lab 

Classroom. 
https://sites.google.com/a/sfnetworkministries.org/ttlclassroom/one-
time-classes/intro-to-powerpoint. 

• PowerPoint SlideFest.  Microsoft. 
http://www.microsoft.com/office/powerpoint-slidefest/do-and-dont.aspx. 

• Images – Clip Art, Photos, Sounds & Animations – Microsoft Office. 
http://office.microsoft.com/en-us/images/. 

• Satterfield, Brian.  How do design a bad presentation.  Techsoup. 
http://www.techsoup.org/learningcenter/training/page6702.cfm?utm_so
urce=newsletter&utm_medium=email&utm_term=lc&utm_content=apr1
&utm_campaign=btc.  Last accessed 4/5/11. 

• Satterfield, Brian.  How do deliver a bad presentation.  Techsoup. 
http://www.techsoup.org/learningcenter/training/page6703.cfm?utm_so
urce=newsletter&utm_medium=email&utm_term=lc&utm_content=apr1
&utm_campaign=btc.  Last accessed 4/5/11. 
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Sources and help 
• Wood, William. 2011.  Teach yourself visually PowerPoint 2010.  Evergreen catalog:  

https://evergreen.lib.in.us/opac/en-
US/skin/default/xml/rdetail.xml?r=18882574&ol=4&t=powerpoint%202010&tp=keyword&l=4&d=0&hc=25&rt=ke
yword.  Last accessed 4/8/11. 

• Matthews, Carole Boggs.  2010.  Microsoft Office PowerPoint 2010 quicksteps.  Evergreen catalog:  
https://evergreen.lib.in.us/opac/en-
US/skin/default/xml/rdetail.xml?r=17795533&ol=4&t=powerpoint%202010&tp=keyword&l=4&d=0&hc=25&rt=ke
yword.  Last accessed 4/8/11. 

• Weverka, Peter.  2010. PowerPoint 2010 all-in-one for dummies.  Evergreen catalog:  
https://evergreen.lib.in.us/opac/en-
US/skin/default/xml/rdetail.xml?r=18859959&ol=4&t=powerpoint%202010&tp=keyword&l=4&d=0&hc=25&rt=ke
yword.  Last accessed 4/8/11. 

• Cox, Joyce.  2010.  Microsoft PowerPoint 2010 step by step.  Evergreen catalog:  
https://evergreen.lib.in.us/opac/en-
US/skin/default/xml/rdetail.xml?r=17811808&ol=4&t=powerpoint%202010&tp=keyword&l=4&d=0&hc=25&rt=ke
yword.  Last accessed 4/8/11. 

• Rutledge, Patrice-Anne.  2011.  Using Microsoft PowerPoint 2010.  Evergreen catalog:  
https://evergreen.lib.in.us/opac/en-
US/skin/default/xml/rdetail.xml?r=18328093&ol=4&t=powerpoint%202010&tp=keyword&l=4&d=0&hc=25&rt=ke
yword.  Last accessed 4/8/11. 

• Office.  Microsoft website (use Internet Explorer browser).  http://office.microsoft.com/en-us/.  Last accessed 
3/30/11. 

• Microsoft Office 2010 Basics.  WebJunction. http://www.webjunction.org/office2010.  Last accessed 3/28/11. 
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